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CHAPTER 1
How Office 2000
Works for You
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E very release of Microsoft Office brings us closer to a fully integrated environ-
ment where each tool works seamlessly with every other tool. Microsoft
Office 2000 is no exception. In fact, simplifying the user experience and
increasing the integration between Office components were two of the key

objectives Microsoft had in developing this product. Office 2000 is a powerful appli-
cation even on a stand-alone computer, but it is designed as a workgroup tool, and
that is where it really shines. If you are a single user, don’t fret; Office 2000 will do
most everything you ask of it, and more. And if you want to share your work with
others, you can use Office 2000 to communicate with other users around the world
through the Internet. However, if you want to truly experience the muscle contained
in Office 2000, there is no substitute for a workgroup environment. Microsoft has
gone all out to make Office 2000 the ultimate platform for the business user.

With Office 2000, you can produce impressive proposals, manage your busy calen-
dar, track important contacts, make sound financial projections, create dynamite pre-
sentations, and establish and maintain a sensational presence on your corporate
intranet or the World Wide Web.

There are several editions of Office 2000, including the Small Business Edition with
Word, PowerPoint, Publisher, Excel, and Outlook, and the Premium Edition, which
includes Word, Access, Excel, FrontPage, Outlook, PhotoDraw, PowerPoint, and Pub-
lisher. Microsoft Office Professional 2000, the version we cover in this book, features
some of the most popular and powerful software programs around. The suite includes
32-bit versions of six applications:

Word: The most popular Windows word processor

Excel: A powerful and easy-to-use spreadsheet application

Access: A true relational database for the Windows platform

PowerPoint: A presentation tool that allows anyone to create slide shows

Outlook: A convenient desktop information manager

Publisher: A highly accessible desktop publishing system

These applications are the latest, most powerful versions of Microsoft’s award-
winning office productivity tools. If you have worked with prior releases of these
products, you’ll want to learn some new techniques for the Office 2000 version.
Office 2000 programs support better integration: between applications, between
yourself and other users, and with the Internet and intranets. All applications
include the greatly improved Office Assistant, shown in Figure 1.1, an active help
feature that offers timesaving advice to help you work more efficiently.
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FIGURE 1.1
Clippit, the newly
refurbished Office

Assistant, is ready and
able to come to 

your aid.

Office Professional 2000 also includes a number of smaller tools or applets:

Internet Explorer 5.0: The latest release of the popular Internet browser

OfficeArt: A line-drawing and art manipulation program

WordArt: A text graphics program

Chart: A charting program

Clip Gallery: A program that helps you organize all your clip art and other
multimedia objects, such as sound and video files

The applets are available from within all the major applications, so you can add
line art, clip art, graphic representations of numeric data, or a text-based logo to any
Office document.

What’s New in Office 2000
The most significant improvements to Office 2000 center around its seamless integra-
tion with the Web. Microsoft has adopted HTML (hypertext markup language), the
Internet standard, as an Office 2000 standard format. Quite simply, this means that doc-
uments you create in Office no longer have to be converted before you can post them to
the Web, and you no longer have to wonder if the person you are sending e-mail to can
open your documents. Word documents can be saved directly in HTML and reopened
in Office without losing any functionality. Your colleague across the continent with a
Macintosh can still open fully formatted Office documents you send her as long as she
has a Web browser on her system. If you’ve ever been frustrated trying to open an impor-
tant e-mail attachment (or if someone else has been unable to open something you’ve
sent), you can appreciate how valuable this innovation alone is.
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU6

The adoption of HTML also means that corporate intranets just got a whole lot
richer. Users around the enterprise can now create documents in Office and (with
appropriate permissions) post them to the Web without any special training in Web
document creation. Internet Explorer 5.0, which is included in Office 2000, can open
documents in HTML and the standard Office 2000 file format. Accessing a Web server
is as easy as saving a file to your hard drive with the new Open and Save As dialog
boxes, shown in Figure 1.2.

FIGURE 1.2
The newly designed
Save As dialog box
makes it as easy to

save documents to a
Web server as to a file

server.

Collaborating Across the Web
Microsoft is working to improve the functionality of Web pages you create in Office
by providing tools that turn them from repositories of static data into living, breath-
ing information animals. Office 2000 offers tools to make collaboration easier and
provides data analysis and reporting tools that can be used on active data accessible
on the Web. Office 2000 Web collaborations features include:

Web Discussions: Use Web Discussions to hold threaded discussions within
Office documents.
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Web Subscriptions and Notifications: When you are working on a team
project, Office 2000 will notify you via e-mail when new documents are posted
or changes made to existing documents.

Presentation Broadcast: Viewing a PowerPoint presentation across the
Web can now be a communal affair with real-time chat and live information
sharing about the presentation’s content.

Online Meetings: Using Microsoft NetMeeting, users can activate a meeting
across a network from any of the Office applications. Participants can use
options for real-time collaboration on documents, including chat and white-
board windows.

For teams that want to analyze live data across a network, Office 2000 offers three
exciting new tools:

Office Web Components let you work interactively with real-time data
across an intranet using PivotTables, spreadsheets, and charts.

Web Query Wizard takes data from any site on the Web and brings it into
Excel for your analysis. Data can be refreshed on request or can be set up to
automatically refresh at specified intervals.

Data Access Pages make developing live Web databases a practical possibil-
ity. If you’ve ever tried to create active server pages from your database, you
know that it is no easy task—until now. Data Access Pages provide front-end
forms in HTML format that are linked to data housed in Access. When users
make changes on the forms from their browsers, the changes are immediately
reflected in the database.

Simplifying the Office Environment
The Office Advisory Council is a group of Microsoft’s corporate customers who partic-
ipated in design reviews during the development of Office 2000. When this group put
together their wish list for Office 2000, Microsoft found that over 25 percent of the
requested features were already included in Office—people simply didn’t know where
to look for them. This prompted Microsoft to look for ways to make the product eas-
ier to use and its features more accessible. One result is that you’ll find a personalized
interface that adjusts to the way you work. Features you use most often are readily
available on the toolbars and menu bars, and those you use less frequently are hidden
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU8

from view. You’ll also find it much easier to customize toolbars by checking the but-
tons you want to see and unchecking those you never use. Figure 1.3 shows the 
buttons available on the Formatting toolbar.

FIGURE 1.3
It’s easy to add and

remove buttons from a
toolbar with the new

button checklist.

Layout and design are becoming more important aspects of any document you
produce. New views in Word, PowerPoint, and Outlook make it easy to see your work
from different angles and work between views. Word’s Print Layout and Web Layout
views let you see how your documents will look in both forms. PowerPoint’s Tri-Pane
view, shown in Figure 1.4, allows you to see and work with slides, outlines, and pre-
sentation notes in one convenient view. In Outlook’s Web view, you can review your
schedule, explore a Web page, or preview your e-mail all within one simple interface.
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FIGURE 1.4
PowerPoint’s Tri-Pane

view lets you work
between views with a

click of the mouse.

Improving on the Basics
Two long-awaited features of Office 2000 may make you wonder how you ever did
without them: Collect-and-Paste and Click-and-Type. In an earlier version of Office,
we were introduced to the spike, a well-hidden feature that let you cut multiple items
and paste them all together in one place—kind of like gathering the kids up and
putting them in the car. The problem with the spike is that you couldn’t see what was
being held there and could only cut items, not copy them. Office 2000’s new Collect-
and-Paste toolbar, shown in Figure 1.5, lets you cut and copy up to 12 items and then
paste them individually or as a group. You can point to any item on the Collect and
Paste toolbar to get a tip telling you what the item is.

FIGURE 1.5
The new Collect and

Paste toolbar
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU10

The second long-awaited feature, Click-and-Type, is designed specifically for Word
and works only in Print Layout and Web Layout views. No more moving to the center
of a page with hard returns and tabs before you can type on it. With Click-and-Type
you click the cursor into place anywhere on the page and start typing. Word automat-
ically inserts all the necessary hard return and tab codes you need to get to where you
want to be.

Another feature designed to make life easier is Microsoft Office E-Mail. E-mail func-
tionality has been extended in the applications so that you no longer need to send
documents as attachments—the documents, including spreadsheets, become the
body of the e-mail. All you have to do is click on the E-Mail button on the Standard
toolbar, and a message header is added to the document, as shown in Figure 1.6.

FIGURE 1.6
In Office 2000 you can
send any Word docu-
ment or Excel spread-

sheet as an e-mail
message.

¿Habla Usted Ingles?
To respond to the growing demands of the global marketplace, Office 2000 includes
incredible new features that can automatically detect languages in a document and
apply the appropriate proofing tools. Although not every world language is available,
Microsoft has amassed an amazing number of dictionaries that can be installed using
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the Microsoft Language Pack, which comes with Office 2000. As the Spelling and Gram-
mar tool is checking your document, it switches languages and dictionaries on the fly.
Even synonyms are available in your chosen language from the Office Thesaurus.

For languages with different characters sets and word-breaking rules, such as Japan-
ese, Office 2000 provides additional formatting tools and custom options. Figure 1.7
shows some of the options available when the Japanese language is installed.

FIGURE 1.7
The Microsoft

Language Pack builds
options for different
languages into the

Microsoft Office 
applications.

Of Special Interest to System Administrators
Office 2000 was designed with corporate-wide adoption in mind. In fact, Microsoft
calls Office 2000 the first version of Office that is truly an enterprise application.
Office 2000 integrates with Microsoft NT, Internet Explorer, Microsoft SQL Server,
Microsoft Exchange Server, and development tools such as Visual Basic. It has been
designed to improve communication, collaboration, and application development
across networks in large and small organizations alike. With the addition of the
Microsoft Office Developer’s Edition, administrators have all the tools they need to
effectively roll out Office throughout the enterprise. The Developer’s Edition includes
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU12

Visual Basic for Applications source code control integration, a Package and Deploy
Wizard for application distribution, tools to design and support dynamic Web con-
tent, and other features that assist with database connectivity.

Greater Ease of Administration
Besides ease of use, Microsoft made ease of administration a major Office 2000 objec-
tive. From its newly designed installation process to its self-repairing applications,
Office 2000 is designed to reduce the cost of PC ownership by giving greater IT con-
trol over deployment, administration, and maintenance across the enterprise.

One of the most obvious enhancements to Office 2000 is the flexible and control-
lable installation process, which includes an Install on Demand feature and a Network
Installation Wizard. Install on Demand means that you don’t have to be concerned if
you don’t install all the right options the first time around. If there is a feature you need
that isn’t installed, Office prompts you to install it on the fly, as shown in Figure 1.8.

FIGURE 1.8
Office 2000’s Install on

Demand feature
prompts you when you

want to use a feature
that is not installed.

The administrator can set up where the Office files will be located, on a server or a
CD, and then the user can decide whether to install the feature. This means that
unnecessary features do not have to be installed until and unless they are needed.

Office 2000 can run from the desktop, from a network file server, or from a terminal
server depending on the degree of control and flexibility that is required. Office 2000
reduces the need for a high-powered server because even with the Run from Server
option, processing occurs on the users’ desktops.

Office 2000 also includes these helpful installation features:

• Microsoft Office Custom Installation Wizard allows administrators to customize
installations down to the level of individual features, toolbars and menus.
Administrators can create custom profiles that determine what options and fea-
tures are available to individual users.

• Intelligent Install determines the user’s previous setup and migrates existing
preferences and settings.
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Reduced End-User Support Requirements
When do your users most often call the help desk? Usually, it’s when a critical applica-
tion won’t run. Office 2000 has the ability to repair itself when it develops a problem
with a missing or corrupted file. When an Office 2000 application boots, it automati-
cally checks to make sure all the required files—including core executables, the reg-
istry, and key DLLs—are present and in good repair. If it discovers a problem, it fixes
itself without even notifying the user there was a problem to begin with.

When users do experience a problem with an application, they can make use of the
Detect and Repair option that is part of the installation program. Detect and Repair
verifies all of the files that were installed and reinstalls any files that are inconsistent
with the original install. In most cases, this should solve the problem without having
to involve IT support directly.

Ever since Office 95, Microsoft has been actively improving the online user assis-
tance available in Office products, and Office 2000 takes this to new ground. Thanks
to a customizable office assistant and increased use of interactive help, users can find
many of the answers to their everyday questions without calling for support. In an
intranet, administrators can customize Help to give users instructions for completing
company-specific forms or spreadsheets. Similarly, administrators can customize
alerts and dialog boxes to direct users to company resources to help them solve prob-
lems and find the information they need. Although users may have to be encouraged
to make use of these online resources, more often help desk personnel will be able to
rely on the old grade school adage, “Look it up yourself!”

The Office 2000 Interface
Although Office 2000 looks and feels much like previous versions of Office, experi-
enced users will immediately notice that only one row of toolbars is displayed when
they open Word, Excel, or PowerPoint. In reality, the Standard and Formatting tool-
bars are both there; they’ve just been displayed side by side to increase the display
space for the document window. You’ll also be immediately introduced to the Office
Assistant. The default Office Assistant is a restyled Clippit, but you can right-click on
Clippit and choose another assistant. The Office Assistant is there to answer all your
Office 2000 questions and entertain you while you work. Later in this section, you’ll
learn how to tone down your assistant or even turn it off completely, if you’d prefer.

For now, let’s take a tour of the Office 2000 interface. If you’ve never worked in the
Windows environment before, this will be a good introduction. If you’re an experi-
enced user, you can skim this section, focusing on what’s new.

THE OFFICE 2000 INTERFACE
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU14

The Application and Document Windows
The Office 2000 applications share a common user interface. This means, for example,
that once you get familiar with the application window in Excel (Figure 1.9), getting
around in the application window in Word will be a piece of cake. Likewise, you’ll
notice a lot of other similarities between the applications.

FIGURE 1.9
Most elements of the

Excel application win-
dow are common to

all Office applications.

At the top of each application window is a title bar that contains three buttons:
Minimize, Maximize or Restore, and Close. Use these buttons to change the size of
your window or to close the window itself. When you’re working in an application,
you’ll usually want to maximize it. Before you switch to something else, minimizing
the first application will free up system resources, making more memory available 
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to the active application. When a window is maximized, the Restore button is 
displayed.

When a window is restored to partial size, the Maximize button is displayed.

Office 2000 employs a new paradigm for managing open windows, called SDI or
Single Document Interface. First introduced in Outlook 97, SDI essentially means that
each document window operates independently of the application. The biggest
advantage of SDI is that every open document appears on the Windows Taskbar; each
appears with the appropriate application icon. This makes it much easier to switch
between documents without having to access the Window menu to see what’s open.
The downside is that having two open documents looks the same as having more
than one session of an application running.

When you only have one document open in an application, a document Close
button appears at the right end of the menu bar beneath the application Close button
on the title bar. Clicking the document Close button closes the document but leaves
the application running. With SDI, when you have multiple documents open in the
same application, there is no document Close button. Clicking the Close button on
the title bar does not close the application—it only closes the active document, leav-
ing the application running for the other open documents. SDI is on by default in
Word and off by default in Excel. To turn it on in Excel, choose Tools ➣ Options ➣
View and check the Windows In Taskbar box.

The Document Window
In each application, your work area is known as the document window. Here you’re sur-
rounded by the tools you need to get the job done: scroll bars to move the display, a
status bar to keep you informed of an operation’s progress, and the command bars at

THE OFFICE 2000 INTERFACE
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU16

the top of the screen to access all the program’s features. There are two types of com-
mand bars: menu bars and toolbars. The menu bar organizes the features into cate-
gories: File, Edit, Help, etc. Clicking on any of the categories opens up a list (a menu)
of related features for you to choose from. Many of the menu bar options open dialog
boxes that allow you to set several options at once related to the feature you choose—
all the print options, all the font settings, etc. Ellipsis characters (...) identify a menu
option that displays a dialog box. The keystrokes listed to the right of a menu item are
for shortcut keys; see “Accessing Commands in Other Ways” later in this chapter for
information on shortcut keys.

Toolbars are the command bars with graphical buttons located below the menu
bar. Toolbars make many of the most commonly used features only one click away. In
Office 2000 the menu bar displays little buttons to identify those features that are also
located on a toolbar. You’ll use toolbars when you want a shortcut to a common fea-
ture and the menu bar when you want to see all the options related to a feature.

Personalized Toolbars and Menu Bars Adapt to Your Work
Habits
Menu bars and toolbars are now designed to adapt to the way you use the Office
applications. Menus, such as the one shown in Figure 1.10, collapse to display only
commonly used commands until you choose to expand them to see the full list of
options.

FIGURE 1.10
Menus expand to show

all of the available
commands.
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Some buttons that were previously available on the Standard and Formatting tool-
bars are not displayed, so that both toolbars can occupy a single row. To access a button
that is not visible, click the More Buttons button located on the right end of each of the
two toolbars. This opens a menu, shown in Figure 1.11, with additional button choices.
When you find the button you are looking for, click it to activate the command and
move the button to the active toolbar. Most often, this will replace some other button
you haven’t used in a while. There are approximately 20 buttons visible at any given
time, but this number varies depending on the width of the buttons you have selected.
You’ll find buttons that were replaced on the More Buttons menu the next time you
need them. Although this may take a little getting used to, after a while, you’ll find
most of the buttons you use regularly displayed on your toolbars.

FIGURE 1.11
Clicking any of the but-

tons on the More
Buttons menu moves

the button to the active
toolbar.

Adding Toolbar Buttons Is a Snap
If you find there is a button you are looking for that isn’t available on the toolbar or
the More Buttons menu, click the More Buttons button and click Add or Remove But-
tons. Any button that is checked is currently displayed on either the toolbar or the
More Buttons menu. Check any button to move it to the active toolbar.

For more about customizing toolbars and menu bars, refer to Chapter 38.

Accessing Commands in Other Ways
If toolbars and menu bars aren’t enough, you can also execute commands from context-
sensitive shortcut menus (sometimes informally called context menus) or by using short-
cut keys. For example, to copy selected text in any application, you can use any of these
techniques:

• Click the Copy button on the Standard toolbar (if it’s visible) or choose the
Copy button from More Buttons if it is not.

• Choose Edit ➣ Copy from the menu bar (see Figure 1.10).

• Right-click on the selected text and then choose Copy from the menu that
appears.
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU18

• Hold Alt and press E to open the Edit menu, then press C to select the Copy
command.

• Hold Ctrl and press C.

Notice that the Copy button and the keyboard shortcut are both shown on the Copy
menu selection, so you can use the menu bar to help you identify quicker ways to
access features you commonly use. ToolTips provide additional help with commands.
If you’re uncertain which toolbar button to use, point to the button and hover for a
moment; a ToolTip will appear, showing the button’s name. ScreenTips are a similar
feature, appearing with other screen elements; for example, when you scroll through
a PowerPoint presentation, a ScreenTip shows your current slide number.

TIP To access different shortcut menus, right-click on various parts of the document or
application window. The menu options vary depending on where you are clicking.

Even though there is usually more than one way to complete a task, no single
method is always more efficient than another. If, for example, you’re completing a
series of tasks that use the mouse, it’s most efficient to use the toolbar or context
menu rather than take your hand off the mouse, hold Ctrl, and press a letter. To be a
proficient user, you’ll want to learn different methods that support the way you create
documents in Office 2000. If you don’t have prior experience with the newer Win-
dows applications, experiment with the context menu—it’s a speedy shortcut in
many situations.

The Office Assistant
The Office Assistant is Microsoft’s “social help interface” for Office 2000. Modified sig-
nificantly from Office 97, the Office Assistant is now a separate application called an
agent, which, like SDI windows, operates independently of the open application. The
Office Assistant crosses all applications, and provides help for specific features of each
application. You can choose from several Assistants from the Assistant Options. Each
has its own “personality.” The Assistant will offer help the first time you work with a
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feature or if you have difficulty with a task. Sometimes the offer is subtle; in Figure 1.12,
the light bulb over Clippit, one of the characters you can select, means that you can
click the Assistant to receive a tip that could save you time and energy.

FIGURE 1.12
The light bulb is a clue

that the Assistant has
something to say.

Other offers of help are a bit more intrusive. If, for example, you open a wizard, the
Office Assistant pops up to ask if you’d like help with the feature.

After you’ve worked with Office 2000 for a few days, you might decide that you’d
like a little less help from your eager Assistant. To change the Assistant’s options, click
on the Assistant, choose Options to open the Office Assistant dialog box, and then
click the Options tab to display the Options page, shown in Figure 1.13.

FIGURE 1.13
The Office Assistant
dialog box lets you

adjust the amount of
support you get from

the Assistant.

The Office Assistant is shared by all the Office 2000 programs. Any options you
change affect the Assistant in all the Office programs, so if you request an increased
level of assistance with Excel, you get the same increased level of assistance with Word.
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CHAPTER 1 • HOW OFFICE 2000 WORKS FOR YOU20

When you’re ready to go it alone, you can hide the Assistant by right clicking on
the Assistant and choosing Hide. If you choose Hide often enough, you may be
given the option shown in Figure 1.14.

FIGURE 1.14
Hiding the Office

Assistant may make it
feel unwanted.

If you start to get lonely, choose Help ➣ Microsoft Word Help to invite the Assis-
tant back into your office.

TIP For help with any dialog box in Office 2000, click the dialog box Help button (the
button with the question mark), and then click on the item you want help with.

What’s Next
Now that you have a feel for what Office 2000 is all about, Chapter 2 will show you
everything you need to know to get started creating Office 2000 documents. You’ll
see how to save documents, edit documents and print. Best of all, you’ll learn how to
use some of Office 2000’s exciting new features such as Collect-and-Paste and the
Places view.
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